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Welcome to the Terrain Engine 2D User Manual. Here you'll find all the
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information you need to begin using the engine!

GENERAL ~ Table of Contents

e What is Terrain Engine 2D?
e Where do [ begin?

MAIN PROPERTIES ~

What is Terrain Engine 2D?

Terrain Engine 2D is a fast and full featured Unity 2D block engine. It
allows you to procedurally generate complex and destructable 2D

terrain through a simple terrain generation framework. With this
framework you can generate almost anything you can imagine. There
are a few example projects included in the asset which can get you
started, or continue reading through the documentation for more
information.
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Where do | begin?

The user manual is here to help you get started with the engine.
Checkout the Intro tab for information on the contents of the engine and
how to setup your scene. The General tab holds all the important
information you need to start using the engine. The Main Properties tab
holds in depth information on all the features of the engine which will be
useful to you if you wish to gain a better understanding of how
everything works!

You can also have a look at the API for information about all the classes
and functions, or checkout the FAQ if you have any questions.
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Here is a list and explanation of all the main assets of Terrain Engine 2D.

INTRO ~
Note that this does not include any extra files and example projects included in the asset.

GENERAL ~ Table of Contents

e Graphics
MAIN PROPERTIES ~ .

e Objects

e Prefabs

e Scripts

G raph ICS contains all the base textures and materials for the engine

Materials contains all the base materials for the engine

i Lighting Contains all the materials for the lighting
o BasicLight.mat The material used for any basic light
o BlockLighting.mat The material used by the blocklighting system
o FastBlur.mat A material used by the Advanced Lighting system for blurring
the light textures
o LargeLight.mat The material used for large light sources
o LightBlend.mat A material used by the Advanced Lighting system for
blending light textures
o Overlay.mat A material used by the Advanced Lighting system for overlaying
textures
o SmallLight.mat The material used for small light sources
e FluidMesh.mat The material used for the mesh generated by the Fluid Chunks
e FluidTextured.mat The material used for the FluidRenderer to render the fluid
texture
e GridSelector.mat The material used for the Grid Selector
e Lightlcon.mat The material used by the Grid Selector to show the lighting icon

L Sprite.mat The material used for the Sprites that use Z-ordered layering

Shaders contains all the shaders for the engine

i Lighting Contains all the shaders for the lighting
© BlockLighting.shader Shader used for rendering the block lighting
o FastBlur.shader shader used for blurring light textures
o LightBlend.shader Shader used for blending light textures
o LightSource.shader shader used on all light sources
o LightSpread.compute Compute Shader used to to generate the block

lighting

Fluid.shader shader used for rendering the fluid texture

Sprite.shader Replacement for the Default Sprite shader with ZWrite enabled
Terrain.shader shader used for terrain textures

Ul-Default.shader Built in Unity shader used by the Overlay material

Sprites Contains all the sprites for the engine
e Lighting Contains all the Sprites for the lighting
o Large_Light_Radial.png Sprite used for large radial lights
o Small_Light_Radial.png Sprite used for small radial lights

Circle_Fill.png ui toggle button fill

Circle_Outline.png Ul toggle button image outline

Circle_Outline_Z.png Ul color wheel outline image

Color_Wheel.png Ul radial color wheel image for the fluid color picker

Grid_Selector.png The image of the Grid Selector

Overlap_Block_Template.png Template used for creating Overlap Blocks

ObjeCts All the generic asset objects used by the engine

e FluidDensitylnputValidator.asset Object used by the OSD Fluid Density Input to

ensure proper formatting of input values

PrEfabs All the Prefabs used in the engine

e Lighting prefabs of light sources
o AdvancedRaycastLight.prefab An advanced Raycast light which shoots
raycasts to the edges of the terrain to generate shadows
o FlashLight.prefab An advanced dynamic raycast light which rotates to face the
cursor
o FloodLight.prefab Alight source which floods the general area with light
o RaycastLight.prefab Alight source which shoots Raycasts in a circular manor
around the light to generate shadows
® Torch.prefab An example block light with a simple texture and particle effects
® Single Instance Prefabs of GameObjects which should only contain one instance per

scene

O

GridSelector.prefab The Grid Selector tool for modifying the generated world

o

OSD.prefab The On Screen display for modifying the generated world

o

World.prefab The World which controls all components of the engine

o

WorldCamera.prefab The main Camera which displays the terrain, lighting
and Ul on the screen

i Chunk.prefab The prefab used to generate the chunks which render the world

° LayerOption.prefab A potential layer option for the OSD

Scrlpts All the source scripts used in the engine

Editor custom Editor scripts

L PI’OjeCtEditOI‘.CS A collection of functions used to help update old projects to the
latest version of TE2D

e ProjectStartup.cs Any tasks that must run when the project starts to ensure TE2D
works properly

o WOI‘ldCUStOD’III]SpeCtOI‘.CS This script controls the custom inspector for the
World

EXtras custom Editor scripts

o CursorFollower.cs This class causes its GameObiject to follow the cursor

e FaceCursor.cs This class causes a 2D GameObiject to rotate to face the cursor

1 MonoBehaviourSingleton.cs This abstract class is used as a base for all scripts
that should act as Singletons

L4 TexturedMesh.cs Generates a custom texture and renders it to a mesh

Fluid Dynamics The scripts used to simulate the Fluid Dynamics System

e Advanced Fluid Dynamics The scripts used by the Advanced Fluid Dynamics
system
o AdvancedFluidBlock.cs This class stores the information for blocks of fluid
of the advanced system
o AdvancedFluidDynamics.cs This class simulates the advanced fluid
physics
© FluidType.cs The type of fluid, used by the Advanced Fluid Dynamics system

Basic Fluid Dynamics The scripts used by the Basic Fluid Dynamics system
o BasicFuidBlock.cs This class stores the information for blocks of fluid of the
basic system

o BasicFluidDynamics.cs This class simulates the basic fluid physics

FluidBlock.cs This class stores the information of a single block of fluid

FluidChunk.cs This class generates the fluid mesh for a single chunk

FluidDynamics.cs This class simulates the fluid physics

FluidRenderer.cs This class renders the fluid simulation in a texture

Lighting The scripts used for the Lighting

e Advanced Lightil’lg The scripts used for the Advanced Lighting system
o Block Lighting This class controls the ambient lighting
= AmbientLight.cs This class controls the ambient lighting
u BlOCkLighting.CS This class controls the block lighting system
. BlockLightSource.cs A source of light for the Block Lighting system
o Mesh LightS The scripts used for the mesh light sources
= AdvancedRaycastLight.cs The script that controls the
AdvancedRaycastLight light source
. FlOOdLight.CS The script that controls the FloodLight light source
u MeShLight.CS The script for a source of light that generates a mesh
. RaycastLight.cs The script that controls the RaycastLight light source
o AdvancedLightSystem.cs This class controls the advanced 2d lighting
system
o LightRenderer.cs Renders the advanced lighting
o LightSOUI'CG.CS The base light source script
o LightSystem.cs This class controls the basic world lighting

PhYSiCS The scripts used for object physics in the engine

A PhYSiCSObjeCt.CS A custom physics script for objects used with the engine

Serialization rhe scripts used for file 1/0 and serialization of data

e AdvancedFluidData.cs serializable script for saving advanced fluid data

e BaseData.cs Base serialization script for any save data

e BlockData.cs serializable script for saving block data

e FluidData.cs serializable script for saving fluid block data

e SaveData.cs Script holding any data to be saved to a file

e Serialization.cs static class for saving and loading data

i SerializationHelper.cs Static class of helpful functions for serialization

e WorldData.cs ScriptableObject holding all preferential data (world inspector data)

for the world

Terrain rhe scripts responsible for generating, modifying and controlling the
terrain
e BlockGridMesh.cs The class is used to create a 2D mesh made up of blocks
¢ BlockInfo.cs This class stores information of a single block type
L BlockLayer.cs This class holds block layer data and information
e Chunk.cs The class controls a single chunk
e ChunkLoader.cs This class controls loading and unloading of chunks
e ColliderGenerator.cs The class generates the colliders for a chunk
e FallingBlockSimulation.cs The class controls the Falling Block Simulation
e TerrainGenerator.cs This class is meant to be expanded upon, it contains the
framework for generating the terrain
e TerrainGeneratorTemplate.cs This is the template for creating a
TerrainGenerator script
e World.cs This is the main World class which holds all block layers and other

important information for controlling the terrain

Tools the tool scripts

e CameraController.cs This class handles input and controls the camera

e ChildCameraController.cs This class maintains the orthographic size of a child
camera with the parent

L GridSelectorImageSetter.cs This class changes the image of the Grid Selector

e OSDController.cs This class controls the OSD

L WorldInputHandler.cs This class handles user input

e WorldModifier.cs This class contains functions for modifying the terrain

Ul the scripts used by the user interface
e ColorPicker.cs The script used to control the color picker of the OSD
L FluidDensityInputValidator.cs The script used to create Fluid Density Input
Validator objects
¢ LinkBoX.CS A component attached to the World GameObject showing relevant links

to help users of the engine
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This page explains how to setup your scene to work with Terrain Engine

2D.

INTRO ~

GENERAL ~ Table of Contents

MAIN PROPERTIES ~  Starting a new project
e Setting up the Menu Example

e Recommended Settings

Starting a new project

1. Start by creating a new scene where the terrain will be generated, it
is recommended to start with a new scene in order to avoid any
issues you may encounter with other assets or settings.

2. Import the Terrain Engine 2D Asset Package into the project.

3. Ensure that TextMesh Pro is installed by opening up the
PackageManager found under Window in the top menu bar (if you
see TextMesh Pro in the list of 'In Project' items, then it is installed).

4.Import the TextMesh Pro essentials by selecting: Window ->
TestMeshPro -> Import TMP Essential Resources from the top
menu bar.

5.Add these three layers to your Unity project: Terrain, Lighting,
Ignore Lighting (watch this video if you don't know how to do this).
To clarify these are Unity project layers, not Terrain Engine 2D block
layers.

6. Clear the hierarchy of all GameObjects.

7.Add in all the TE2D GameObijects by selecting: GameObject ->
Terrain Engine 2D -> Create All from the top menu bar.

8. Generate a new World Data object by clicking the 'Generate New
World Data' button found in the World inspector.

9. Setup your block data (Refer to Block Setup)

10. Create a new Terrain Generator script (Refer to Terrain Generation)

11. Setup your preferences in the World Custom Inspector (Refer to
Main Properties)

12. That's it! Try hitting 'Play' and test out your new world!

Setting up the Menu Example

Note that the Menu Example can be used to load any world scene, the
SideScrollerExample scene is used here as an example, but you could
also use the TopDownExample, OriginalExample, or any other scene with
the TE2D objects, just be sure to set the correct World Data Object in
the inspector of the GameManager GameObject.

WARNING all files are saved in the same place, careful not to load a
saved World with the wrong scene (and wrong World Data Object).

1. Load the Menu Example scene

2. Open up the Build Settings (File -> Build Settings or Ctrl + Shift + B)

3.Press the Add Open Scenes button

4. Repeat steps 1-3 for the SideScrollerExample scene

5. With the Build Settings still open ensure that the MenuExample
scene is in the top position (index 0) and the SideScrollerExample is
just below it (index 1). You can reposition them by clicking and
dragging.

6. Then you can close out of the Build Settings and reload the Menu
Example scene.

7. As a last check, select the GameManager GameObject from the
Hierarchy and ensure the SideScrollerWorldData object is added to
the World Data field of the GameManager's inspector.

8.Now you're all set, the Menu Example is ready to go! Hit play and test
it out.

Recommended Settings
Global Lighting Window window - Lighting - Settings (Unity 2018)

Open the Global Lighting Window (Window -> Lighting -> Settings). In
the Scene tab under Environment Lighting set the Ambient Color to
White (#FFFFFF). All other lighting settings should be disabled.

Quality SEttingS Edit - Project Settings - Quality (Unity 2018)
e Rendering Anisotropic Textures: Disabled
e Rendering Anti Aliasing: Disabled

Texture Settings

e Texture Type: Sprite
Generate Mip Maps: Disabled
Wrap Mode: Clamp

Filter Mode: Point

e Compression: None

Materials

For any tileset materials used for the Block Layers the recommended
shader is the included shader labeled 'Terrain' found under:
'TerrainEngine2D /Terrain.

For any Sprites that you wish to place inbetween terrain layers you must
use the included shader labeled 'Sprite' found under:

'TerrainEngine2D /Sprite'. There is also an included Sprite material for
this purpose.
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This page explains how to setup your art textures and tilemaps for use in
INTRO ~
the engine.

GENERAL ~ Table of Contents

e The Basics
e Creating the Artwork
e Textures in Unity

MAIN PROPERTIES ~

e Materials

The Basics

Terrain Engine 2D uses tilesets in order to render the beautiful terrain
you see in the examples. In general these tilesets are very easy to setup,
although there are a few rules you must follow in order to get everything
working properly.

The terrain is made up of layers and each layer has its own set of block
types. The layers determine the order in which blocks are rendered.
Generally you will have a background layer, a main layer, and a
foreground layer.

Each layer has its own tileset containing textures for all of the blocks
which that layer contains. These are stored as Materials in Unity.

The very first thing you will want to figure out when planning your game
is how many layers you will have, and what kind of blocks you will want
in each layer. Although don't worry too much about getting down every
single block and layer right at the start, as it is easy to make changes and
add more blocks in later on.

Creating the Artwork

Once you have decided on your layers and have some ideas of the blocks
you want to create, you can get started on creating your first tileset.

The tilesets used for Terrain Engine 2D are pretty straight forward, and
there are plenty of examples included with the engine to help you out.

Now before you start creating tilesets and artwork to use with the block
engine, you first need to decide what your Pixels Per Block ratio is going
to be. This is the side length of a single tile in pixels. We recommend you
stick with powers of 2 (8, 16, 32, etc). Generally the higher ratio you use,
the more detailed your blocks are going to have to be. In the included
example we went with a Pixels Per Block ratio of 8.

Once you know what your Pixels Per Block ratio is, you can begin by
creating your first block.

Block Types

In Terrain Engine 2D we currently support three types of blocks. The
Default block which is just a simple single block tile, this is used for any
blocks which only take up one tile and don't require any kind of special
blending. The Multi Tile block is similar to the Default block, except it
takes up multiple tiles per block, this kind of block will likely be used for
decoration and large objects. Lastly we have what we call the Overlap
Block, this block is special in that it uses Bitmasking to render
transitions and blend with the surrounding blocks. This block will likely
be used for your terrain.

Default Tile Mult Tile Overlap Tile

Terrain Engine 2D Tile Types

Overlap Block

Overlap Block's are unique in that certain portions of the texture are
rendered depending on the surrounding blocks. They will overlap into
other tiles to allow for nice transitions (or blending) between different
block types.
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Terrain Engine 2D Overlap Block Examp

Overlap Blocks are 3 tiles in height and 2 tiles in width. Each Overlap
Block is made up of two sections; the Main section which holds the main
tile graphic, and the Secondary section which holds the Corner Blend
Squares. The Middle Square of the Main section is always rendered. The
Edge Rectangles are only rendered if there is no adjacent block of the
same type at that edge. The Corner Blend Squares are rendered on top
of the Edge Rectangles if there is an adjacent corner block. The Corner
Blend Squares are mapped to the proper position as show by the color
in the image below.

Figure 1 Figure 2 Figure 3

Se::ondar\,-

Comner Blend Square

"™ Middle Square

Terrain Engine 2D Overlap Block Info

The purple pixels represent the inside of the block and the black pixels
act as a border to the outside. The Middle Square is the main texture of
the block, it should not contain any border within it as it will be tiled. The
surrounding area around the Middle Square acts as border tiles which
are rendered if the block is on an edge. The colored squares represent
the area that the corner pieces will align with. The corner pieces replace
the border in that position in order to connect corner blocks (as shown in
Figure 3).

Below is an included template to help you to create Overlap Blocks. The
Blend Square Map shows how the Corner Blend Squares will be placed
relative to the tile. The Render Area shows the different parts of the
block which may be rendered to the Mesh. The Basic Template is what
you should use as a guide to creating your own Overlap Blocks. The
Example is a variation of Hard Dirt taken from Tiles_Main (the tileset for
the Main layer).

Blend Square Map Render Area Basic Template Example

Terrain Engine 2D Overlap Block Template

Variations

Each block can have as many variations as you would like. This allows
you to further randomize your terrain and prevents any patterns from
forming. We recommend you have at least 3 variations for any block used
for terrain. To add a variation to your block simply create a variant of
your block artwork in the adjacent right tile.

Terrain Engine 2D Variations Example

Textures in Unity

When adding your textures in Unity you should use the Recommended
Settings for Textures found in Setup.

The recommended property settings for your tileset textures are shown
below. Just be sure that your Pixels Per Unit is the same as your chosen
Pixels Per Block ratio. These settings will give you a nice sharp pixel art

style.
Texture Type | Sprite (2D and UI) $
Texture Shape 2D
Sprite Mode | Single 4 |
Packing Tag
Pixels Per Unit 8
Mesh Type | Tight al
Extrude Edges = 1
Pivot | Center al
I Sprite Editur]
¥ Advanced
sRGB (Color Texture) 4
Alpha Source | Input Texture Alpha 3 ]
Alpha Is Transparency v
MNon Power of 2 | Nane »
Read/Write Enabled L]
Generate Mip Maps L
Wrap Mode | Clamp s |
Filter Mode | Paint (ne filter) $ ]
Aniso Level () 1
Default 4+ & E
Max Size 2048 s |
Resize Algorithm Mitchell $ |
Compression Mone al
Format Auto
| Revert || Apply |

Terrain Engine 2D Texture Properties
L]
Materials

Once you have all of your tileset textures created and added to Unity, the
next step is to setup your layer Materials. Every tileset texture will need
to be added to a new Material which will later be linked with its layer
during Block Setup.

Shader

You have the option to use whatever shader you wish for your tileset
textures, although there are a few properties your shader must include
or you risk breaking parts of the engine.

All shaders used for tilesets must have a 2D property for the texture and
have ZWrite On otherwise the Z-Ordered Rendering will not work
properly. Any tilesets using Overlap Blocks also need to use a
Transparent Cutout shader. The recommended shader for tilesets is
the: TerrainEngine2D/Terrain shader.

Material Setup

1. Start by creating a new Material in the Project Window of Unity.
2. Select your desired shader.

3. Add your tileset texture to the Material's Texture parameter.

4. Setup the shaders parameters.
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o This page explains how to setup your layer and block types in the World
INTRO ~
custom inspector.

GENERAL ~ Table of Contents
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e Block Properties
e Layers

e Blocks

Basics

In Terrain Engine 2D the terrain is made up completely of blocks. As the
developer you have complete control over all of the blocks in your game.
In order to make everything simple and easy Terrain Engine 2D contains
a convinent tab in the custom inspector of the World called 'Block Setup'
Inside the Block Setup tab you can setup all of the blocks which will be
used in your game. Here you can add, remove, modify, and rearrange all
of the layers and blocks in your game.

Block Properties

Pixels Per Block

The Pixels Per Block property is the amount of pixels that make up a
single side length of one tile in your block textures. This property should
be set to your desired Pixels Per Block ratio which you would have
needed to determine to create your textures.

Z Block Distance

The Z Block Distance is the z distance between each Block Type when
they are rendered to the scene, it is used to set render order for your
blocks.

Z Layer Factor

The Z Layer Factor is the factor which determines the z distance
between each different block layer. This distance is set by multiplying the
Z Layer Factor with the Z Block Distance.

Layers

In Terrain Engine 2D all of your blocks are arranged in layers, where each
layer has its own set of Block Types. Layers are used to group your
blocks and control render order. Typically you will have a background,
main, and foreground layer. In the custom inspector there is a
Reorderable List which allows you to add, remove, rearange, and modify
the layers.

Layer Properties

e Name Give a name to the layer
e Enable Colliders set whether the layer will use colliders
e Tileset Material set the Material for the layer (this Material should contain the

tileset texture)

Adding Layers

To add a new layer to the reorderable list, click the '+' sign at the bottom
right of the list gui.

¥/ ¥ World (Script) %=

| Main Properties Block Setup

Blocks

Pixels Per Block:
Z Block Distance:

+ Layers
Layers

List is Empty

Select block layer: + |

Terrain Engine 2D Adding Layers

Removing Layers

To remove a layer to the reorderable list, select the layer which you wish
to remove, then click the '-' sign at the bottom right of the list gui.

v ¢ ¥ World (Script) (wWES
| Main Properties Block Setup
Blocks
Pixels Per Block: g8
Z Block Distance: 1
« Layers
Layers
= Name: Layer O
Enable Colliders: -
Tileset Material: None (Material) (o]
= Name: Layer 1
Enable Colliders:
Tileset Material: None (Matenal) o]
— Name: Layer 2
Enable Colliders: [ |
Tileset Matenal: MNone (Matenal) (o]
R + -
Selart hlack lavar: [ Lavern s
Terrain Engine 2D Removing Layers

Render Order

The render order of the layers is controlled by the order of the layers in
the list. Layers closer to the top/start of the list will be rendered first,
and the other layers rendered on top. You can rearange layers by
dragging them around.

v ¥ World (Script) G %,

| Main Properties Block Setup

Blocks

Pixels Per Block:
Z Block Distance:

« Layers
Layers
= Name: Layer 0
Enable Colliders: -
Tileset Material: None (Material) (o]
= Name: Layer 1
Enable Colliders:
Tileset Material: None (Matenal) (o]
Layer 2
n
MNone (Matenal)
[ A
Salart hlack laver: | Lavero .

Terrain Engine 2D Rearanging Layers

Blocks

Each layer has its own Reorderable List of blocks where you can define
all of the Block Types for that layer. Similarly to the Layer list you can
add, remove, rearange, and modify all the blocks in the custom inspector.
Only one Reorderable List is shown at time, which you can select using
the Dropdown button in the inspector.

Blocks

Pixels Per Block:
Z Block Distance:

| | Layers
Select block layer: | Background $
Baclground Blocks
= Name: Sand
Overlap Block: ) Transparent: -
Variations: 4
Texture Width: 2 Texture Height: 3
Texture X Position: 0 Texture Y Position: 0
= Name: Dirt
Overlap Block: v Transparent:
Variations: 4
Texture Width: 2 Texture Height: 3
Texture ¥ Position: 0 Texture ¥ Position: 3
+
Terrain Engine 2D Block Reorderable List

Block Setup

Whenever you add a new block to the Reorderable Block List you need to
set the Block Properties of that newly define block. The properties are
self explanitory, but it is important to remember that Texture properties
represent only the portion of the texture which represents that block.
These properties are also all in Block Units, meaning you set the Texture
Width, Texture Height, and Texture Position by the number of tiles (for
example: a Default Block would have a Texture Width of 1 and a Texture
Height of 1). Refer to the Example Scene included in the Asset Package if
you have any confusion on setting up the blocks in your scene.

Block Properties

e Name Give a name to the block

® Overlap Block set whether this is an Overlap block

e Transparent Set whether this block's texture contains any transparent pixels

e Variations Set the number of texture variations for this block

o Texture Width set the width of this block (in block units)

e Texture Height Set the height of this block (in block units)

e Texture X Position Set the x position of this block in the texture (in block units)

e Texture Y Position Set the y position of this block in the texture (in block units)

° Falling Block This property only shows up if the Falling Block Simulation is enabled
and you are working with the Falling Block Layer. It allows you to set whether the block

will fall with gravity

Render Order

Each Block Type has its own unique render order (or z position), this is
only important for Overlap Blocks which may overlap other blocks. The
render order of the blocks is controlled by the order of the blocks in the
list. Blocks close to the top/start of the list will be rendered first, and the
other blocks on top.
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This page explains all of the Main Properties in the World custom
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inspector.

GENERAL ~ Table of Contents
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e Fluid

e Lighting
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MAIN PROPERTIES ¥

General

The Main Properties tab of the World custom inspector acts as the hub
for controlling the engine. It holds all of the most important properties
which you need to have access to in order to setup your terrain and any
other features you wish to utilize in your game.

v« ¥ World (Script) @ =
World Data Object: Bl WorldData (WorldData) o}
| Generate New World Data || Retrieve Old Data |

| | save Changes in Play Mode

¥ Terrain

» Chunks

» Modification
¥ Fluid

¥ Lighting

» Falling Blocks
b Optimization

Terrain Engine 2D World Inspector

World Data Object

v = ¥ World (Script) Q= %
World Data Object: None (World Data) o

[ Generate New World Data |

Terrain Engine 2D Inspector World Data Object

Before you can begin setting up your world you must generate a new
World Data Object. This object will serialize all of the fields found in the
World Inspector. In other words it will store all of your settings, which
controls everything from how the terrain is generated, to how quickly
fluid can flow. This acts as a convenient object to access through scripts
for modifying settings at runtime or getting information. It also allows
you to transfer world data between projects, and helps keep data safe
when updating the asset.

Note: You can click on any of the property titles below for more detailed
information.

Terrain - cick here

¥ Terrain
Terrain Generator Script: « World (TerrainGeneratorExample) (o]
Auto Save: L] Load World: (J
Name: Worldl
Width: 1024
Height: 128
Seed: 2518781 | Random Seed |
| Generate World |

Terrain Engine 2D Terrain Properties

e Terrain Generator SCI‘ipt The custom script used for procedurally generating the
world

e Auto Save Saves the generated terrain to file in playmode

e Load World 1.oads terrain from file in playmode

e Name The name of your world (used as the save file name)

e Width The total width of the world (in block units)

° Height The total height of the world (in block units)

e Seed a integer value used to procedurally generate the world

e Random Seed Randomly generate a seed

e Generate World Generates the terrain in the editor and saves it to file

¥ Terrain
Terrain Generator Script: + World (TerrainGeneratorExample) (o]
Auto Save: - Load World: o
[ Select World Directory I
Mame: World 1
Width: 1024
Height: 128

Seed: -7895948

Terrain Engine 2D Load Terrain Properties

e Select World Directory Opens a pop-up menu for selecting the directory of the

world for loading

Chunks

¥ Chunks
Chunk Size: 16
Load Transform: None (Transform) ©
Load Rate: 0.1
Load Distance: 48

Terrain Engine 2D Chunk Properties

Chunk Size The side length of a chunk (in block units)

Load Transform The Transform of the GameOject where chunks will be loaded

L.oad Rate The rate at which chunks are checked and loaded into the scene

Load Distance The horizontal distance from the object which chunks will load in

Modification

¥ Modification

Toggle OSD: 4 0SD Update Rate: 0.05

0SD Scale: ) 1 ]
Enable Input Handler: 4

Max Modify Radius: 3

Toggle Cursor: v

Terrain Engine 2D Modification Properties

i Toggle OSD Toggle for enabling /disabling the On Screen Display (OSD)

e OSD Update Rate The rate at which the OSD updates its values (in seconds)

e OSD Scale The scale factor use to resize the Ul of the OSD

e Enable Input Handler Enable or disable the Input Handler in favour of using your
own custom input controller

e Max MOdify Radius The max size of the Modify Radius

b Toggle Cursor Show or hide the mouse cursor in game

Fluid

¥ Fluid

Disable fluid: -
Select Fluid Layer: | Main s
Render Fluid as Texture: -
Basic Fluid: L]
Simulation

Top Down: L]

Run Simulation: v

Update Rate: 0
Physics Properties

Max Weight: 1

Min Weight: 0.005

Stable Amount: 0.0001

Pressure Weight: 0.2
Modification

Fluid Drop Amount: 0.1

Terrain Engine 2D Fluid Properties

e Disable Fluid pisables the fluid simulation, fluid rendering, and prevents placement of
fluid

e Select Fluid Layer Choose the block layer to use for the fluid simulation

e Render Fluid as Texture Select this if youwant to render the fluid as a single
texture using the Fluid shader (smooths out the edges and gets rid of the blockly look, but
may also be slower)

e Basic Fluid select this if you wish to use the faster but simpler basic fluid simulation

Simulation

e Top Down Fluid simulation used in a top-down style 2d game (fluid flows equally in all
directions)

e Run Simulation Toggle the fluid simulation

e Fluid Update Rate The rate at which the fluid simulation updates (in seconds)

Physics Properties
e Max Weight The maximum amount of liquid a single block can hold (unpressurized)
e Min Weight The minimum amount of liquid a single block can hold
e Stable Amount If the amount of fluid flowing out of a block is less than the stable
amount, the fluid block is stable
e Pressure Weight Fluid weight pressure factor (each fluid block can hold

pressureWeight more liquid than the block above it)

Modification

e Fluid DI‘Op Amount Amount of fluid added on drop

Basic Fluid Properties

main Color: I
Secondary Color: | _|f

Terrain Engine 2D Basic Fluid Properties

e Main Color The main color used for the fluid (used for blocks containing high amounts
of fluid)
° Secondary Color The secondary color used for the fluid (used for blocks containing

low amounts of fluid)

Advanced Fluid Properties
Surface Filling (Experimental): ¥

Fluid Mixing Factor: 0.2
Fluid Types
Density: 0 &l WaterFluid (FluidType)
— Density: 1 &l PoisonFluid (FluidType)
= Density: 2 &l LavaFluid (FluidType) (o]

Terrain Engine 2D Advanced Fluid Properties

e Surface Filling This feature allows fluid of a different density to fill the surface of
another fluid to satisfy the remainder of the current block height (Warning: This is an
experimental feature as it can cause weird behavior)

e Fluid Mixing Factor The interpolation factor used to determine how the color is
shared between two mixing fluids (larger values favor the color of the added fluid)

e Fluid Types Areorderable list allowing you to setup multiple fluid types.

Lighting

¥ Lighting
Disable lighting: L]
Basic lighting: [
Light Layer: | Main &
Amount of light bleed: 2

Terrain Engine 2D Basic Lighting Properties

e Disable Lighting Disables the light system and prevents light updating

e Basic Lighting Select this if youwish to use the faster but simpler basic lighting
system

. Light Layer Choose the block layer to use for generating the shadow mask

e Amount of light bleed The number of blocks from the edge of the terrain which will

be visible
¥ Lighting

Disable lighting: J

Basic lighting: J

Block Lighting
Light Layer: | Main t]
Intensity Factor: a8
Transmission Factor: 30

Ambient Light Disable: J
Ambient Light Layer: | Main ¢
Intensity Factor: 8
Transmission Factor: 30
Use Height Map: (v

Day Cycle
Pause Time: (v
Time Factor: 100
Time of Day: 'S, 12
Day Color: [ | 2
Night Color I
Time of Sunrise: 7
Time of Sunset: 19
sunrise and Sunset: -~ —N_

Post Processing
Down Scale: )
MNumber Blur Passes: ) 3

Terrain Engine 2D Advanced Lighting Properties
Block Lighting

° Light Layer Choose the block layer to use with the block lighting system

e [ntensity Factor The global intensity of the light, used to determine how far the light
can propagate from a light source

e Transmission Factor The global transmission factor, used to determine how much

light is lost when transmitting through a block

Ambient Light

e Disable Disables the ambient lighting

e Ambient Light Layer Choose the block layer to use for ambient lighting

e Intensity Factor The global intensity of ambient lights, used to determine how far
the light can propagate from a ambient light source

e Transmission Factor The global transmission factor for ambient lights, used to
determine how much light is lost when transmitting through a block

e Use Height Map Whether to use a height map to generate the ambient lighting (only

blocks above the surface of the terrain will be illuminated to mimic sunlight)

Day Cycle

e Pause Time rause the day/night cycle and movement of time

e Time Factor The factor used to determine how fast time will go by in game (a factor
of 1is realtime)

e Time of Day The current time of day, used to control the ambient light color

° Day Color The color of the ambient lighting during the day (time between one hour
after sunrise and sunset)

e Night Color The color of the ambient lighting during the night (time between one
hour after sunset and sunrise)

e Time of Sunrise The time at which the ambient lighting will begin to switch to the
Day Color

e Time of Sunset The time at which the ambient lighting will begin to switch to the

Night Color

Post Processing

e Down Scale The amount to scale down the lighting texture (in powers of 2), creates a
blurring effect
e Number Blur Passes The number of times the lighting texture will be blurred before

itisrendered to screen

Falling Block Simulation

¥ Falling Blocks

Disable falling blocks: L]
Falling Block Layer: | Main A
Update Rate: 0.05

Terrain Engine 2D Falling Blocks Properties

e Disable fallmg blocks Disable the falling block simulation, no blocks will fall with
gravity

° Falling Block Layer This is the layer which can contain falling blocks

o Update Rate The rate at which the Falling Block Simulation will run (higher rate means

slower update time)

Optimization

v Optimization
Overlap Blend Squares: L]
Occlusion Culling: |

Terrain Engine 2D Optimization Properties

o Overlap Blend Squares Allows the option to overlap the 'blend squares' (used when
generating Overlap Blocks) over the block's edges. By default the blend squares replace
the block edge, but this adds a lot more vertices and triangles to the generated mesh

e Occlusion Culling If this option is selected blocks that are hidden behind other

layers will not be rendered
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User Manual - V1.25
This page explains all about how the World Camera works.
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e Follow Camera

e Pixel Perfect Properties

General

The World Camera is used to render the world and all of its wonderful
features. It is made up of 3 seperate cameras all controlled by the Light
Renderer. If basic lighting is enabled, then the world only uses 1 camera.
However if Advanced Lighting is enabled, then all three cameras are used
in order to render the advanced 2d lighting. The Main Camera is used to
capture anything that is not in the Lighting, Ignore Lighting, or Ul Unity
Layers, such as the Terrain. The Light Camera captures any light
sources such as any mesh lights, block lighting, or ambient light. The
Overlay Camera will capture anything in the Ul and Ignore Lighting
layer. The three camera's are combined so that the lighting will render on
top of the main graphics, and the overlay will render on top of that. In
this way you can have certain sprites and graphics which will not be
effected by lighting.

There is also a powerful camera controller which will allow you to
smoothly manouver around the world through a variety of inputs.

Controls
Input Camera Controls
Arrow Keys/WASD Camera vertical and horizontal movement

Right click and drag Pan the world

Scroll Zoom in and out

Hold Shift Move/Zoom at double speed

Camera Properties

The Camera Properti